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1. COMPUTER MEMORY AND STORAGE DEVICES

WWORKSHEET ORKSHEET 1.11.1

Worksheet 1.1Class 4 – 1. Computer Memory and Storage Devices

A.  Multiple Choice QuestionsA.  Multiple Choice Questions
 1. Computer uses which type of memory while working? 

  (a) Primary memory 

  (b) Secondary memory 

  (c) Both a and b

  (d) Tertiary memory 

 2. Which is the smallest unit of data?

  (a) Byte  (b) Bit 

  (c) Megabyte (d) Gigabyte 

 3. Computer uses data from which of the following while working? 

  (a) Hard disk  (b) RAM

  (c) Pen Drive (d) Memory card 
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Worksheet 1.1Class 4 – 1. Computer Memory and Storage Devices

B.  Fill in the blanks.B.  Fill in the blanks.

 permanent         temporary         auxiliary memory

 1. RAM has ______________ memory.

 2. ROM has ______________ memory.

 3. Secondary memory is also called ______________ memory.

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. RAM has non-volatile memory. 

 2. Hard Disk has volatile memory. 

 3. A byte is larger than a bit. 

D.  Match the Columns.D.  Match the Columns.
  Column A Column B

 (1) One Megabyte  (a) 1024 MB

 (2) One Gigabyte  (b) 1024 GB

 (3) One Terabyte  (c) 1024 KB

E.  Answer these questions.E.  Answer these questions.
 1. What is the difference between primary memory and secondary memory? 

 2. What is the full form of RAM? What is the use of RAM? 

 3. What is the full form of ROM? What is its significance? 
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1. COMPUTER MEMORY AND STORAGE DEVICES

Answer KeysAnswer Keys

Answer KeysClass 4 – 1. Computer Memory and Storage Devices

Worksheet 1.1
A. (1) Primary memory, (2) bit, (3) RAM
B. (1) temporary, (2) permanent, (3) auxiliary memory
C. (1) F, (2) F, (3) T
D. (1) c, (2) a, (3) b
E. 1.  Primary memory is used by computer while the computer is working but data cannot be 

stored in primary memory. Secondary memory is used for storing data and is permanent 
in nature. 

 2.  RAM stands for Random Access Memory. It is the primary memory of computer. 
When you work on computer, primary memory is utilized for processing data. But data 
cannot be stored in RAM. 

 3.  ROM stands for Read Only Memory. ROM is used for permanently storing data. Once 
data is written on ROM, it cannot be erased or re-written. 
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1. COMPUTER MEMORY AND STORAGE DEVICES

WWORKSHEET ORKSHEET 1.21.2

Worksheet 1.2Class 4 – 1. Computer Memory and Storage Devices

A.  Multiple Choice QuestionsA.  Multiple Choice Questions
 1. Memory card is used in which of the following to store data? 

  (a) Desktop  (b) Laptop 

  (c) Tablet (d) Digital camera 

 2. A computer generally stores data in which of the following? 

  (a) Hard disk  (b) RAM

  (c) CD-R (d) CD-RW

 3. What is the other name of RAM?

  (a) Volatile memory  (b) Non-volatile Memory

  (c) Random Memory (d) Hard Disk
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Worksheet 1.2Class 4 – 1. Computer Memory and Storage Devices

B.  Fill in the blanks.B.  Fill in the blanks.

 Card Reader             cloud                  100

 1. One Drive is an example of ______________ storage. 

 2. A Blue Ray Disc can store data up to 25 GB to ______________ GB.

 3. Data transfer from a memory card to the computer with the help of a card 
reader is called ______________.

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. A megabyte is large than a gigabyte. 

 2. DVD can store up to 4 GB data. 

 3. A memory card also called memory stick. 

D.  Match the Columns.D.  Match the Columns.
  Column A Column B

 (1) One Petabyte  (a) 1024 PB

 (2) One Exabyte  (b) 1024 TB

 (3) Google Drive (c) cloud storage

E.  Answer these questions.E.  Answer these questions.
 1. What are the similarity and difference between CD and DVD? 

 2. Write a short note on Blu Ray Disc. 

 3. What is a Pen Drive and Cloud Storage.
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1. COMPUTER MEMORY AND STORAGE DEVICES

Answer KeysAnswer Keys

Answer KeysClass 4 – 1. Computer Memory and Storage Devices

Worksheet 1.2
A. (1) Digital camera, (2) Hard disk, (3) Random Memory
B. (1) cloud, (2) 100, (3) Card Reader
C. (1) F, (2) T (3) T
D. (1) b, (2) a, (3) (c)
E. 1.  Both are examples of secondary memory and are optical memory devices. CD can store 

a less amount of data compared to DVD. CD stands for Compact Disc, while DVD 
stands for Digital Versatile Disc. 

 2.  Blu-ray disc is the latest and most superior type of storage disk. The name blu-ray 
comes from the fact that a blue-violet laser beam is used to store data on it. The storage 
capacity of a blu-ray disc is ten times more than a DVD. It can store from 25 GB to 
100 GB of data. We can read or write data on a blu-ray disc with the help of a blu-ray 
reader.

 3.  A pen drive is a portable and small storage device. Pen drive is used to transfer large 
amount of information from one computer to another. We can use a pen drive by 
inserting it in the USB slot of the computer. Cloud Storage is used to store data over 
the Internet. The data is actually stored on a hard disk that be located at a place far away 
from us or even in a different country.
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2. MANAGING FILES AND FOLDERS IN WINDOWS 10

WWORKSHEET ORKSHEET 2.12.1

Worksheet 2.1Class 4 – 2. Managing Files and Folders in Windows 10

A.  Multiple Choice QuestionsA.  Multiple Choice Questions
 1. Which letter is assigned to the main drive on Hard Disk? 

  (a) B (b) C

  (c) D (d) E

 2. What is Cortana? 

  (a) File viewer (b) Folder viewer

  (c) Virtual assistant  (d) Drive E

 3. Which keyboard shortcut is used for copying a file from a folder? 

  (a) Ctrl + F (b) Ctrl + Fold

  (c) Ctrl + C  (d) Ctrl + V
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Worksheet 2.1Class 4 – 2. Managing Files and Folders in Windows 10

B.  Fill in the blanksB.  Fill in the blanks

 folder             File explorer             name

 1. ______________ is a utility program to easily view a file. 

 2. A ______________ may contain many files. 

 3. A file icon displays the ______________ of file. 

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. Windows 10 was released in 2010.  

 2. Windows 10 supports multitasking.  

 3. Windows 10 does not support multiple desktops.  

D.  Match the Columns.D.  Match the Columns.
  Column A Column B

 (1) Microsoft Word  (a) .pptx

 (2) Microsoft Power Point  (b) .xlsx

 (3) Microsoft Excel  (c) .docx

E.  Answer these questions.E.  Answer these questions.
 1. What do you understand by a file?

 2. What is file explorer?

 3. What is a folder?
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2. MANAGING FILES AND FOLDERS IN WINDOWS 10

Answer KeysAnswer Keys

Answer KeysClass 4 – 2. Managing Files and Folders in Windows 10

Worksheet 2.1
A. (1) C, (2) virtual assistant, (3) Ctrl + C
B. (1) File explorer, (2) folder, (3) name
C. (1) F, (2) T, (3) F
D. (1) .docx, (2) .pptx, (3) .xlsx
E. 1.  A collection of data that is stored in the form of text, pictures, music or video is called 

file. 
 2.  File explorer is a utility program in Windows. It is used for viewing, moving, renaming, 

etc. of files. It provides quick access to a file. 
 3.  A collection of related files is called a folder. Creating a folder makes it easy to manage 

files. A folder may also contain several subfolders.
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2. MANAGING FILES AND FOLDERS IN WINDOWS 10

WWORKSHEET ORKSHEET 2.22.2

Worksheet 2.2Class 4 – 2. Managing Files and Folders in Windows 10

A.  Multiple Choice QuestionsA.  Multiple Choice Questions
 1. Which keyboard shortcut is used for removing a file from a folder so that it 

can be placed in a different folder? 

  (a) Ctrl + R (b) Ctrl + F

  (c) Ctrl + C (d) Ctrl + X 

 2. A file in notepad is generally saved with which extension? 

  (a) .doc (b) .docx

  (c) .txt  (d) .ntp 

 3. Which of the following operations moves a file to the Recycle Bin?

  (a) Rename (b) Move

  (c) Delete  (d) Window
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Worksheet 2.2Class 4 – 2. Managing Files and Folders in Windows 10

B.  Fill in the blanksB.  Fill in the blanks

 Renaming               Recycle bin               Ctrl + V

 1. Deleted file is moved to ______________ .

 2. Keyboard shortcut for pasting a file is ______________ .

 3. ______________ means changing the name of an existing file or a folder.

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. Windows 10 can also run on tablets.  

 2. A folder inside another folder is called super folder.  

 3. A folder helps us organise our files on the computer. 

D.  Match the Columns.D.  Match the Columns.
  Column A Column B

 (1) Microsoft Access (a) .txt

 (2) Notepad (b) .docx

 (3) Microsoft Word (c) .xlsx

E.  Answer these questions.E.  Answer these questions.
 1. How will you delete a file?

 2. How will you move a file from one folder to another?

 3. Write down the steps to creating a folder.
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2. MANAGING FILES AND FOLDERS IN WINDOWS 10

Answer KeysAnswer Keys

Answer KeysClass 4 – 2. Managing Files and Folders in Windows 10

Worksheet 2.2
A. (1) Ctrl + X, (2) .txt, (3) Delete
B. (1) Recycle bin, (2) Ctrl + V, (3) Renaming
C. (1) T, (2) F, (3) T
D. (1) .accdb, (2) .txt, (3) .docx
E. 1. A file can be deleted by any of the following methods: 
   •  Select a file and press DELETE.
   •  Right click on a file and select DELETE form dropdown menu. 
 2. Follow these steps for moving a file from one folder to another. 
   Select a file and press Ctrl + X.
    Open the folder where you want to move above file. Press Ctrl + V to paste the file at 

new location. 
 3. On Windows: 

 Navigate to the location where you want the folder. 
 Right-click on an empty space. 
 Select “New” → “Folder” from the menu. 
 Type a name for the folder and press Enter.
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3. WORKING WITH SHAPES AND TEXT IN PAINT 3D

WWORKSHEET ORKSHEET 3.13.1

Worksheet 3.1Class 4 – 3. Working with shapes and Text in Paint 3D

A.  Multiple Choice QuestionsA.  Multiple Choice Questions

 1. 3D shapes are grouped under how many categories? 

  (a) Two  (b) Three

  (c) Four  (d) Five 

 2. How many tools are available in 3D Paint to created doodles? 

  (a) Two  (b) Three

  (c) Four  (d) Five 

 3. Paint 3D provides how may standard models? 

  (a) Two  (b) Three

  (c) Four  (d) Five 
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Worksheet 3.1Class 4 – 3. Working with shapes and Text in Paint 3D

B.  Fill in the blanks.B.  Fill in the blanks.

 Library             three             Upload

 1. A 3D shape has ______________ dimensions. 
 2. ______________ option in Paint 3D enables you to use a sticker saved on 

computer. 
 3. To add a model apart from standard model, you need to use 3D 

______________ 

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. You cannot draw 2D shapes in Paint 3D. 
 2. Soft Edge tool can be used for drawing closed 3D curve. 
 3. While using Sharp Edge tool, you need to press Commit button   

to complete the Doodle. 

D.  This figure shows a 3D shape with four grab handles. Label all the grab handles D.  This figure shows a 3D shape with four grab handles. Label all the grab handles 
correctly. correctly. 



3

3. WORKING WITH SHAPES AND TEXT IN PAINT 3D

Answer KeysAnswer Keys

Answer KeysClass 4 – 3. Working with shapes and Text in Paint 3D

Worksheet 3.1
A. (1) Three, (2) Three, (3) Five
B. (1) three, (2) Upload, (3) Library
C. (1) F, (2) T, (3) F
D. (A) Move z-axis, (B) Rotate z-axis, (C) Rotate y-axis, (D) Rotate x-axis 



1

Name:  Date: 

3. WORKING WITH SHAPES AND TEXT IN PAINT 3D

WWORKSHEET ORKSHEET 3.23.2

Worksheet 3.2Class 4 – 3. Working with shapes and Text in Paint 3D

A.  Multiple Choice QuestionsA.  Multiple Choice Questions

 1. Which icon helps in enhancing or lightning the effects on background in 
Paint 3D? 

  (a) Torch  (b) Sun

  (c) Moon (d) Star 

 2. Which type of text can be added in Paint 3D? 

  (a) 2D text (b) 3D text

  (c) Both a and b (d) None

 3. Which of the following tool allows us to draw a long ribbon?

  (a) Text Tool (b) Shark edge

  (c) Tube brush (d) Soft edge
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Worksheet 3.2Class 4 – 3. Working with shapes and Text in Paint 3D

B.  Fill in the blanks.B.  Fill in the blanks.

 doodle             Tube brush               graphic

 1. A closed 3D curve cannot be drawn using ______________ 

 2. Paint 3D is a ______________ software.

 3. Paint 3D provides three tools to create a 3D ______________ .

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. You can rotate a 3D shape along x-axis and y-axis.  

 2. A Bird is one of the standard 3D models in Paint 3D.  

 3. There are three categories of 3D shapes: 3D doodle, 3D objects   
and 3D models.

D.  Answer these questions. D.  Answer these questions. 
 1. Explain various 3D doodle tools in Paint 3D. 

 2. Which are various 3D models available in Paint 3D? 

 3. How will you add a model from 3D library? 

 4. How will you add text to a model in Paint 3D? 

 5. What do you understand by effects in Paint 3D? 
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3. WORKING WITH SHAPES AND TEXT IN PAINT 3D

Answer KeysAnswer Keys

Answer KeysClass 4 – 3. Working with shapes and Text in Paint 3D

Worksheet 3.2
A. (1) Sun, (2) both a and b, (3) Tube brush
B. (1) Tube brush, (2) graphic, (3) doodle
C. (1) T, (2) F, (3) T
D. 1.  Paint 3D provides three tools to create a 3D doodle: Tube brush, Soft edge and Sharp 

edge, to draw freehand 3D objects. The Tube brush ( ) doodle tool keep us draw long 
ribbons or short dollops of 3D volume. Both the Soft edge ( ) and Sharp edge ( ) doodle 
tools keep us draw a close 3D curve.

 2.  Paint 3D provides five standard 3D models, including Man, Woman, Dog, Cat and 
Fish. However, there are many more 3D models available online.

 3.  For using 3D library, the computer must be connected to internet. Click 3D Library in 
the toolbar. This will open options for various categories; such as flowers and plants, 
animals, etc. Choose a model from a selected category. The selected model would appear 
on the Canvas. 

 4. Follow these steps to add text: 
   •  Click Text in toolbar.
   •  Text pane appears on the right pane of window. 
   •  Select 2D or 3D text and type. 
   •  Apply desired font type, size, color, etc. 
 5.  Effects are pre-set tools to enhance a drawing. These effects can be applied to background 

and to the drawing.
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4. PARAGRAPH AND PAGE FORMATTING IN WORD 2016

WWORKSHEET ORKSHEET 4.14.1

Worksheet 4.1Class 4 – 4. Paragraph and Page Formatting in Word 2016

A.  Multiple Choice QuestionsA.  Multiple Choice Questions

 1. What is the keyboard shortcut for finding a text in Word? 

  (a) Ctrl + F (b) Ctrl + F + D 

  (c) Ctrl + H (d) Ctrl + R 

 2. What is the keyboard shortcut for replacing a text in Word? 

  (a) Ctrl + R (b) Ctrl + H

  (c) Ctrl + F + R  (d) Ctrl + F + H

 3. Which of the following appears in each page of a Word document? 

  (a) Header (b) Footer

  (c) Both a and b (d) Page number 
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Worksheet 4.1Class 4 – 4. Paragraph and Page Formatting in Word 2016

B.  Fill in the blanksB.  Fill in the blanks

 Paragraph         Page Setup         Insert

 1. Columns button is present in ______________ group. 

 2. Line spacing tool is present in ______________ group on Home tab. 

 3. Header and Footer tools are present on ______________ tab. 

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. Page Margins tool is present in Page Layout tab. 

 2. Columns tool is present in Insert tab. 

 3. Page Orientation determines printing orientation of a page. 

D.  Match the Columns.D.  Match the Columns.
  Column A Column B

  (1)  (a) Columns

  (2)  (b) Size 

  (3)  (c) Margins

  (4)  (d) Orientation



3

4. PARAGRAPH AND PAGE FORMATTING IN WORD 2016

Answer KeysAnswer Keys

Answer KeysClass 4 – 4. Paragraph and Page Formatting in Word 2016

Worksheet 4.1
A. (1) Ctrl + F, (2) Ctrl + H, (3) Both a and b
B. (1) Page Setup, (2) Paragraph, (3) Insert
C. (1) T, (2) F, (3) T
D. (1) c, (2) d, (3) b, (4) a 
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4. PARAGRAPH AND PAGE FORMATTING IN WORD 2016

WWORKSHEET ORKSHEET 4.24.2

Worksheet 4.2Class 4 – 4. Paragraph and Page Formatting in Word 2016

A.  Multiple Choice QuestionsA.  Multiple Choice Questions

 1. Which tool is used for creating space around a paragraph? 

  (a) Line spacing  (b) Paragraph spacing

  (c) Paragraph alignment (d) Paragraph style 

 2. Which tool is used for dividing a page into three columns? 

  (a) Paragraph spacing (b) Paragraph alignment

  (c) Paragraph style  (d) Column 

 3. Which of the following refers to the amount of vertical space between lines 
of text in a paragraph?

  (a) Paragraph spacing (b) Line spacing

  (c) Sentence spacing  (d) Both (a) and (b) 
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Worksheet 4.2Class 4 – 4. Paragraph and Page Formatting in Word 2016

B.  Fill in the blanksB.  Fill in the blanks

 Orientation         vertical         Indentation

 1. Line spacing increases or decreases ______________ space between lines. 
 2. ______________ is the distance of paragraph from left or right marign. 
 3. ______________ is the property that determines the printing direction of 

the text.

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. There are three types of page orientation.  
 2. You can print all pages of a Word document at one go.  
 3. Header is the area that appears on the top of each page   

in a document.

D.  Answer these questions.D.  Answer these questions.
 1. You typed Fertilisation in Word document but you want to change it to 

Fertilization. But you have used this word at about 50 places in a document. 
How will you change this word with minimum effort? 

 2. You have typed an assignment in MS Word, and you want the title of the 
assignment to appear on each page of the document. How will you achieve 
this with minimum effort? 

 3. What is the use of Print Selection feature in Print dialogue box? 
 4. You need to print only certain pages from a document. How will you do it? 
 5. How will you add border around a paragraph? 
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4. PARAGRAPH AND PAGE FORMATTING IN WORD 2016

Answer KeysAnswer Keys

Answer KeysClass 4 – 4. Paragraph and Page Formatting in Word 2016

Worksheet 4.2
A. (1) Paragraph spacing, (2) Column, (3) Line spacing
B. (1) vertical, (2) Indentation, (3) Orientation
C. (1) F, (2) T, (3) T
D. 1. It will use Find and Replace tool in MS Word: 
   •  Type Ctrl + F → Type Fertilisation in dialogue box.
   •  Type Ctrl + H → Type Fertilization in dialogue box. 
   •  Click OK
   •  Click Close (x) button. 
 2. I will use insert Header option for this: 
   •  Click on Insert Tab 
   •  Select Header from Header and Footer Group.
   •  Cursor appears in Header of the page
   •  Type the title and select suitable font style, color, size, etc. 
   •  Click anywhere outside the header.
 3. Print Selection feature is used for printing only the selected text from a page. 
 4.  After opening the print dialogue box, select Custom Print. Type page numbers of pages 

you want to print and then click on Print. 
 5. Select the paragraph by dragging mouse. 
   •  On the Page Layout tab, select Page Borders from Page Background Group. 
   •  Click on Borders tab on the dialogue box.
   •  Select suitable thickness, colour and style of border. 
   •  Click OK.
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5. WORD 2016: WORKING WITH GRAPHIC

WWORKSHEET ORKSHEET 5.15.1

Worksheet 5.1Class 4 – 5. Word 2016: Working with Graphic

A.  Multiple Choice QuestionsA.  Multiple Choice Questions
 1. Insert pictures tool is available in which group of Insert tab? 

  (a) Illustrations (b) Photos 

  (c) Symbols (d) Art 

 2. Which handle can be used to enlarge a picture without distorting height to 
width ratio? 

  (a) Corner sizing handle  (b) Side sizing handle 

  (c) Either a or b (d) Neither a nor b 

 3. Word Art tool is available in which group of Insert tab? 

  (a) Art  (b) Text 

  (c) Illustrations  (d) Symbols 
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Worksheet 5.1Class 4 – 5. Word 2016: Working with Graphic

B.  Fill in the blanksB.  Fill in the blanks

 Insert             beautify             Shapes

 1. You can ______________ a Word document by inserting a picture in it. 

 2. Tool for inserting pictures is present on ______________ tab. 

 3. ______________ tool can be used for drawing circle in Word document. 

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. A triangle can be drawn by using Shapes tool.  

 2. A star cannot be drawn by using Shapes tool.  

 3. Insert Picture tool helps in inserting an image stored on computer.  

D.  Match the Columns.D.  Match the Columns.
  Column A Column B

      Symbol

      Word Art

      SmartArt

     Picture

     Shapes
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5. WORD 2016: WORKING WITH GRAPHIC

Answer KeysAnswer Keys

Answer KeysClass 4 – 5. Word 2016: Working with Graphic

Worksheet 5.1
A. (1) Illustrations, (2) Corner sizing handle, (3) Text
B. (1) beautify, (2) Insert, (3) Shapes
C. (1) T, (2) F, (3) T
D. (1) d, (2) e, (3) b 
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5. WORD 2016: WORKING WITH GRAPHIC

WWORKSHEET ORKSHEET 5.25.2

Worksheet 5.2Class 4 – 5. Word 2016: Working with Graphic

A.  Multiple Choice QuestionsA.  Multiple Choice Questions
 1. Shape tool is available in which group of Insert tab? 

  (a) Art  (b) Shapes 

  (c) Illustrations (d) Symbols 

 2. You will use which tool for displaying Δ in a sentence? 

  (a) Art  (b) Shapes 

  (c) Illustrations (d) Symbol

 3. Which of the following groups of the Format tab is used to change the line 
style of an object?

  (a) Insert Shapes  (b) Shape Styles 

  (c) Design (d) Picture styles
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Worksheet 5.2Class 4 – 5. Word 2016: Working with Graphic

B.  Fill in the blanksB.  Fill in the blanks

 WordArt           symbols           Illustrations

 1. Fancy looking letters can be typed by using ______________ tool.

 2. Picture and Shapes tools are part of ______________ group.

 3. Word allows us to insert ______________ that generally cannot be typed 
from the keyboard.

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. An image can be resized in Word document.  

 2. You cannot crop an image in Word document.  

 3. We can insert various shapes in word such as lines, rectangles   
and arrows by using the insert tab.

D.  Answer these questions. D.  Answer these questions. 
 1. How will you insert a picture in Word document? 
 2. How will you increase the size of an image in Word document? 
 3. How will you show a rectangular image inside an oval in Word document? 
 4. How will you change a colour image into a black and white image in Word 

document? 
 5. How will you write highly stylized word in Word document?
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5. WORD 2016: WORKING WITH GRAPHIC

Answer KeysAnswer Keys

Answer KeysClass 4 – 5. Word 2016: Working with Graphic

Worksheet 5.2
A. (1) Illustrations, (2) Symbol, (3) Shape Styles
B. (1) WordArt, (2) Illustrations, (3) symbols
C. (1) T, (2) F, (3) T
D. 1. Follow these steps to insert a picture in Word document: 
   •  Click on Insert tab. 
   •  Click on Picture in Illustrations group. 
   •  Search the folder where desired image is stored. 
   •  Click on the image and click Insert on Dialogue box. 
 2. Follow these steps to increase the size of an image. 
   •  Select the image. 
   •  Drag handles appear around the image. 
   •  Select any of the four corner handles and drag away from the image. 
   •  Leave drag handle once the desired size of image is visible. 
 3. Follow these steps show a rectangular image inside an oval. 
   •  Select the image. 
   •  Format tab appears on toolbar.
   •  Click the Crop button which appears on right side of toolbar ribbon. 
   •  Click the down button on Crop tool, to see options. 
   •  Click on Crop to Shape. 
   •  Select oval from options. 
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5. WORD 2016: WORKING WITH GRAPHIC

Answer KeysAnswer Keys

Answer KeysClass 4 – 5. Word 2016: Working with Graphic

 4. Select the image. 
   •  Format tab appears on toolbar. 
   •  Click Artistic Effects button. 
   •  Select Grayscale option to change to Black & White. 
 5. Follow these steps to write highly stylized word: 
   •  Click on Insert tab. 
   •  Click on the small arrow below the icon of WordArt. 
   •  Select an option from drop down box. 
   •  A text box appears on Word document. 
   •  Type desired text. 
   •  Change font style, colour, etc.
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6. MORE ON SCRATCH

WWORKSHEET ORKSHEET 6.16.1

Worksheet 6.1Class 4 – 6. More On Scratch

A.  Multiple Choice QuestionsA.  Multiple Choice Questions

 1. What is the colour of motion block? 

  (a) Blue  (b) Purple

  (c) Orange (d) Magenta 

 2. What is the colour of sound block? 

  (a) Blue  (b) Purple

  (c) Magenta (d) Orange 

 3. What is the colour of Events block? 

  (a) Yellow (b) Red

  (c) Purple (d) Orange 
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Worksheet 6.1Class 4 – 6. More On Scratch

B.  Fill in the blanksB.  Fill in the blanks

 Pen              Extension              top

 1. Music and Pen blocks are available in Scratch as ______________ .
 2. Event blocks are generally placed at ______________ of block stack. 
 3. The ______________ block is used for drawing shapes on stage. 

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. You don’t need to pay money for using Scratch.  
 2. Motion block is used for changing the size of an object on stage.  
 3. Pen block is only used for writing letters in Scratch.  

D.  This table shows some examples of use of Pen block. Write a brief description D.  This table shows some examples of use of Pen block. Write a brief description 
for each example.for each example.

  Pen block Description.
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6. MORE ON SCRATCH

Answer KeysAnswer Keys

Answer KeysClass 4 – 6. More On Scratch

Worksheet 6.1
A. (1) Blue, (2) Magenta, (3) Orange
B. (1) Extension, (2) top,(3) Pen
C. (1) T, (2) F, (3) F
D. (1) Sets pen color to a particular color, (2) changes pen color, brightness, transparency, etc. 

(3) Sets pen color, brightness, transparency, etc. (4) Sets pen size to a particular value.
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6. MORE ON SCRATCH

WWORKSHEET ORKSHEET 6.26.2

Worksheet 6.2Class 4 – 6. More On Scratch

A.  Multiple Choice QuestionsA.  Multiple Choice Questions

 1. What is the color of Pen block?

  (a) Blue (b) Green 

  (c) Yellow  (d) Red 

 2. What is the colour of Flag in Go button? 

  (a) Blue  (b) Green 

  (c) Yellow (d) Red 

 3. Where are the Event Blocks generally placed in the Scripts area?

  (a) At the bottom of the block stack

  (b) In the middle of the block stack

  (c) At the top of the block stack

  (d) Outside the block stack
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Worksheet 6.2Class 4 – 6. More On Scratch

B.  Fill in the blanksB.  Fill in the blanks

 Scratch                360                480

 1. The height of stage in Scratch is ______________ pixels.

 2. The width of stage in Scratch is ______________ pixels.

 3. ______________ allows us to add sound of various musical instruments and 
drums in Scratch project.

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. You can compose music by using the music block. 

 2. You can compose music by using the sound block. 

 3. You can set the rotation style of a sprite in two ways in Scratch 3.0. 

D.  Answer these questions.D.  Answer these questions.
 1. What do you understand by Event block? 

 2. What is the meaning of this stack of blocks? 

 3. What is the meaning of below code? 

 4. What is the meaning of below stack of blocks? 



3

6. MORE ON SCRATCH

Answer KeysAnswer Keys

Answer KeysClass 4 – 6. More On Scratch

Worksheet 6.2
A. (1) Green, (2) Green, (3) At the top of the block stack
B. (1) 360, (2) 480, (3) Scratch
C. (1) T, (2) F, (3) T
D. 1.  The Event Blocks are generally placed at the top of block stack in the Scripts area and 

used to start the execution of script. Most blocks in this category start with the word 
‘when’.

 2. When Go button is clicked, the program will produce sound of ROAR for 2 seconds. 
 3. This block will play the selected note for specified number of beats. 
 4. The sprite will move in following steps: 
   Step 1: Sprite will move 10 steps 
   Step 2: Sprite will turn clockwise by 15 degrees. 
   Step 3: Sprite will turn counterclockwise by 15 degrees. 
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7. MICROSOFT POWERPOINT 2016

WWORKSHEET ORKSHEET 7.17.1

Worksheet 7.1Class 4 – 7. Microsoft PowerPoint 2016

A.  Multiple Choice QuestionsA.  Multiple Choice Questions

 1. PowerPoint cannot be used for making which of the following? 

  (a) Presentation (b) Story board

  (c) Photo album (d) Webpage 

 2. Which term is used for individual pages in a PowerPoint presentation? 

  (a) Page  (b) Slide 

  (c) Scratch  (d) Block 

 3. The View Button in PowerPoint shows how many view types? 

  (a) Two (b) Three

  (c) Four (d) Six
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Worksheet 7.1Class 4 – 7. Microsoft PowerPoint 2016

B.  Fill in the blanksB.  Fill in the blanks

 pptx       F5       Closing       presentation       saving

 1. Press ______________ key to view Slide Show. 

 2. PowerPoint files are saved with ______________ extension. 

 3. Ctrl + W is used for ______________ a presentation in PowerPoint. 

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. PowerPoint is free software for users. 

 2. You can add text to a slide.  

 3. You cannot add image to a slide.  

D.  Match the Columns.D.  Match the Columns.
  Column A Column B

   Chart 

   SmartArt 

   Photo 

   Photo Album

   Shapes
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7. MICROSOFT POWERPOINT 2016

Answer KeysAnswer Keys

Answer KeysClass 4 – 7. Microsoft PowerPoint 2016

Worksheet 7.1
A. (1) Webpage, (2) Slide, (3) Four, (4) Ctrl + N, (5) Ctrl + D 
B. (1) F5, (2) .pptx, (3) Closing, (4) saving, (5) presentation 
C. (1) F, (2) T, (3) F, (4) T, (5) T
D. (1) c, (2) d, (3) e, (4) b, (5) a
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7. MICROSOFT POWERPOINT 2016

WWORKSHEET ORKSHEET 7.27.2

Worksheet 7.2Class 4 – 7. Microsoft PowerPoint 2016

A.  Multiple Choice QuestionsA.  Multiple Choice Questions
 1. Which keyboard shortcut is used for creating a new file in PowerPoint? 

  (a) Ctrl + N (b) Ctrl + P

  (c) Ctrl + P + P (d) Ctrl + W

 2. Which keyboard shortcut is used for creating a copy of an existing slide? 

  (a) Ctrl + B (b) Ctrl + C

  (c) Ctrl + D (d) Ctrl + N 

 3. A new blank presentation contains only

  (a) one slide (b) two slide

  (c) three slide (d) four slide

 4. Which of the following tabs contains the option to create a new presentation?

  (a) Home (b) File

  (c) Slide Show (d) None



Grade:  Teacher’s signature: 

2

Worksheet 7.2Class 4 – 7. Microsoft PowerPoint 2016

B.  Fill in the blanksB.  Fill in the blanks

 Ctrl + D key           saving           presentation

 1. Ctrl + S is used for ______________ a presentation in PowerPoint. 

 2. PowerPoint is a ______________ software. 

 3. We can also press ______________ to make a duplicate of the selected slide.

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. A presentation in PowerPoint is a collection of slides.  

 2. Slide show displays slides in a sequence on full screen.  

 3. We can end the slide show by pressing the Esc key on the keyboard. 

D.  Answer these questions. D.  Answer these questions. 
 1. What is PowerPoint? 

 2. What are the key features of PowerPoint? 

 3. What is a slide in PowerPoint? 

 4. What is slide presentation in PowerPoint? 

 5. Briefly describe the title bar in PowerPoint. 

 6. Write a short note on notes pan in PowerPoint. 
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7. MICROSOFT POWERPOINT 2016

Answer KeysAnswer Keys

Answer KeysClass 4 – 7. Microsoft PowerPoint 2016

Worksheet 7.2
A. (1) Ctrl + N, (1) Ctrl + D, (3) one slide (4) File
B. (1) saving, (2) presentation, (3) Ctrl + D key
C. (1) T, (2) T, (3) T
D. 1. PowerPoint is a software used for creating presentations, photo albums and storyboards. 
 2. Following are the key features of PowerPoint: 
   •   It offers various features such as animations and transitions that allow us to create 

attractive presentations. 
   •   It provides readymade colour and design themes that can be used for creating 

presentations quickly.
   •  It allows us to record narrations and use them in the presentation.
 3.  A presentation created using PowerPoint consists of individual pages called slides. A 

slide can contain text, images, audio clips and videos.
 4.  When multiple slides are displayed together in sequence in full-screen mode, it is called 

a slide show.
 5.  It appears at the top of the PowerPoint window. It displays the name of the presentation 

followed by the name of the program (that is, PowerPoint).
 6.  The Notes pane is present below the Slide pane. It lets us add speaker notes for our 

presentation. Speaker notes are kept by the speaker for references. They can only be 
viewed by the speaker and do not appear when the presentation is running.
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8. THE INTERNET

WWORKSHEET ORKSHEET 8.18.1

Worksheet 8.1Class 4 – 8. The Internet

A.  Multiple Choice QuestionsA.  Multiple Choice Questions

 1. Which of the following is not a web browser? 

  (a) Chrome (b) Firefox

  (c) Safari  (d) Acrobat 

 2. Chrome is developed by which of the following? 

  (a) Google  (b) Microsoft

  (c) Apple  (d) Amazon 

 3. Which of the following is an Internet Service Provider or ISP? 

  (a) Google  (b) Jio

  (c) Twitter (d) WhatsApp 
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Worksheet 8.1Class 4 – 8. The Internet

B.  Fill in the blanksB.  Fill in the blanks

 netiquette              Search engine              Microsoft Edge

 1. Google and Bing are examples of ______________.
 2. ______________ means rules and manners to be followed while using 

internet.
 3. ______________ is the default web browser with Windows 10. 

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. It is perfectly safe to send your photograph online and there is no  

need for parental consent. 
 2. Never click on an unknown link.  
 3. You can send e-mail to anyone without a valid reason.  

D.  Match the Columns.D.  Match the Columns.
  Column A Column B

       Chrome

       Edge 

       Opera 

       Safari 

       Firefox
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8. THE INTERNET

Answer KeysAnswer Keys

Answer KeysClass 4 – 8. The Internet

Worksheet 8.1
A. (1) Acrobat, (2) Google, (3) Jio
B. (1) Search engine, (2) netiquette, (3) Microsoft Edge
C. (1) F, (2) T, (3) F
D. (1) d, (2) e, (3) a
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8. THE INTERNET

WWORKSHEET ORKSHEET 8.28.2

Worksheet 8.2Class 4 – 8. The Internet

A.  Multiple Choice QuestionsA.  Multiple Choice Questions

 1. Which of the following activities can be done offline? 

  (a) Surfing the net (b) Online banking 

  (c) E-shopping  (d) Typing a letter 

 2. What is displayed in the address bar of a browser window? 

  (a) Company name  (b) URL

  (c) Name of website  (d) Name of App

 3. Who was developed the World Wide Web in 1989?

  (a) Sir Tom Berners-Lee (b) Sir Tim Berners-Lee

  (c) Sir Tim Merners-Lee (d) Sir Tim Berners-Loo
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Worksheet 8.2Class 4 – 8. The Internet

B.  Fill in the blanksB.  Fill in the blanks

 firefox           Web browser           document

 1. You must have a ______________ on your computer and internet connection 
to access internet.

 2. Mozilla ______________ is an example of web browser.

 3. A web page refers to an individual ______________ available on World 
Wide Web.

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. Never use bad language while chatting online.  
 2. Always create very strong and complicated password.  
 3. A hyperlink may be a text that is usually highlighted in blue and  

underlined or an image.

D.  Answer these questions. D.  Answer these questions. 
 1. What do you understand by internet? 

 2. List any three uses of internet. 

 3. What do you understand by ISP? Why do we need it? 

 4. What is the difference between website and webpage? 

 5. What is the difference between hyperlink and URL? 
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8. THE INTERNET

Answer KeysAnswer Keys

Answer KeysClass 4 – 8. The Internet

Worksheet 8.2
A. (1) typing a letter, (2) URL, (3) Sir Tim Berners-Lee
B. (1) Web browser, (2) firefox, (3) document
C. (1) T, (2) T, (3) T
D. 1. The network of millions of computers all over the world is called internet. 
 2. Following are three uses of internet: 
   •  Searching for information
   •  Online study 
   •  Online shopping 
 3.  ISP stands for internet service provider. We need an ISP to access internet. Jio and 

Airtel are examples of ISP. 
 4.  An individual file on internet is called a webpage and a collection of related webpages 

is called a website. 
 5.  A hyperlink is a link that takes the user to a different file or document from the current 

file. A URL is the unique address of a document on internet. 
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9. ALL ABOUT ROBOTS

WWORKSHEET ORKSHEET 9.19.1

Worksheet 9.1Class 4 – 9. All About Robots

A.  Multiple Choice QuestionsA.  Multiple Choice Questions

 1. Which component of a robot allows it to adapt to its environment? 

  (a) Sensor  (b) Actuator 

  (c) Power supply  (d) Controller 

 2. Industrial robots are more likely to be used at which of these places? 

  (a) Hospital  (b) Car factory 

  (c) Home  (d) School 

 3. Domestic robot can do which of the following tasks? 

  (a) Repairing a bike  (b) Educating a child 

  (c) Mopping the floor  (d) Treating a patient 
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Worksheet 9.1Class 4 – 9. All About Robots

B.  Fill in the blanksB.  Fill in the blanks

 anti-terror             Manav             waste

 1. ______________ is India’s first 3D printed humanoid robot. 

 2. Daksh is first ______________ robot developed in India. 

 3. Shalu is made from 100% ______________ materials. 

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. Robots are still in fantasy and have yet to become reality.  

 2. India has developed many robots indigenously.  

 3. Drone is an example of robot.  

D.  Match the Columns.D.  Match the Columns.
  Column A Column B

 (1) Kempa  (a) HDFC Bank 

 (2) Daksh  (b) Invento Robotics 

 (3) Shalu  (c) Bangaluru airport 

 (4) Mitra  (d) DRDO 

 (5) IRA (e) Female robot
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9. ALL ABOUT ROBOTS

Answer KeysAnswer Keys

Answer KeysClass 4 – 9. All About Robots

Worksheet 9.1
A. (1) sensor, (2) car factory, (3) mopping the floor
B. (1) Manav, (2) anti-terror, (3) waste
C. (1) F, (2) T, (3) T
D. (1) c, (2) d, (3) e
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9. ALL ABOUT ROBOTS

WWORKSHEET ORKSHEET 9.29.2

Worksheet 9.2Class 4 – 9. All About Robots

A.  Multiple Choice QuestionsA.  Multiple Choice Questions

 1. NASA’s Rover is which kind of robot? 

  (a) Industrial robot  (b) Domestic robot 

  (c) Educational robot  (d) Robonaut 

 2. Kempa the robot is being used at which of the following locations? 

  (a) Airport  (b) Railway station

  (c) Hospital  (d) Bus stand 

 3. What is designed to be used for performing surgeries that can be controlled 
by the doctors remotely.

  (a) Surgical robots (b) Domestic Robots

  (c) Industrial Robots (d) Commercial robots
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Worksheet 9.2Class 4 – 9. All About Robots

B.  Fill in the blanksB.  Fill in the blanks

 Shalu               bank                motors

 1. IRA is a humanoid robot which serves customers at ______________ .

 2. Robots need ______________ for movement.

 3. ______________ is the first female humanoid robot in India.

C.  WriteC.  Write T  T for True andfor True and F  F for False.for False.
 1. Robonauts have made it unnecessary to send humans to space.  

 2. Entertainments robots have no real useful application.  

 3. Kempa, Manav, Daksh, Shalu, Mitra and IRA 2.0 are the famous   
Indian robots.

D.  Answer these questions. D.  Answer these questions. 
 1. What do you understand by a robot? 

 2. Which are the key components of a robot? 

 3. Which are the different types of robot? 

 4. Write a short note on surgical robot. 

 5. Write a short note on army robots. 
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9. ALL ABOUT ROBOTS

Answer KeysAnswer Keys

Answer KeysClass 4 – 9. All About Robots

Worksheet 9.2
A. (1) robonaut, (2) Airport, (3) Surgical robots
B. (1) bank, (2) motors, (3) Shalu
C. (1) F, (2) T, (3) T
D. 1.  A robot is a machine that can do complex actions and replicate certain human movements 

automatically by means of commands given to it using programming.
 2.  The key components of a robot are: Sensors, Actuators, Power supply, Electric motors 

and controller.
 3.  There are different types of robots based on application. These are: Industrial robots, 

domestic robots, surgical robots, Robonauts, commercial entertainment robots, army 
robots and education robots.

 4.  Surgical robots are designed to be used for performing surgeries that can be controlled 
by the doctors remotely. They have multiple cameras which provide the doctors a 3D 
view of the region where the surgery is being done. This helps the doctors to operate 
accordingly.

 5.  Army robots (also called military robots) are designed to be used in defence sector for 
performing actions like bomb disposal, border surveillance, etc. A common example is 
drones which are used to capture images and drop tactical weapons, etc.

 


